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Introduction

Features

The EPSON digital camera software suite is the perfect 
companion for your EPSON digital camera. U9sing 
this software together with your digital camera, you 
can save your photos as files on your computer’s hard 
disk. The following list summarizes some of the 
programs included with your PhotoPC 3100Z and 
their features.

❏ EPSON Photo!4 allows you to view and manage 
the image and audio recording files saved on your 
camera’s memory card or in your computer.

❏ EPSON AutoDownloader provides a quick and 
organized way for you to transfer your pictures, 
audio recordings, and video clips from your 
camera to your computer.

❏ EPSON File Converter lets you convert image 
files, audio recordings, and computer screen shots 
that were not made with your digital camera so 
that you can save them in the camera’s memory 
card.

❏ EPSON PhotoQuicker allows you to print photos 
simply and in a variety of ways using your 
computer.

❏ ESPON CameraStarter provides you with a 
convenient way of opening applications for 
printing and downloading the images in your 
memory card.

About This Guide

Finding your way around

This online User’s Guide employs links to make 
navigation simpler. When you move the cursor over a 
link, it changes to a hand icon. You can then click the 
link to access a related topic or more detailed 
information. 

You can also use the bookmarks in the left pane to help 
make navigation easier. Click the bookmark of the 
item you want to view to jump to that item.
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Printing a topic

To print a topic, click Print on the File menu. Before 
printing, be sure to specify a Print Range for the pages 
you want to print.

The information in this guide

The information in this guide is divided into five 
chapters, with an appendix, a glossary, and an index 
provided for reference. The chapters are organized as 
follows.

❏ Chapter 1 contains instructions and information 
on installing the software, and instructions on 
making settings in CameraStarter. Be sure to read 
this chapter first.

❏ Chapter 2 explains how to connect your camera 
to your computer and how to transfer images 
from your camera to your computer.

❏ Chapter 3 provides you with a complete 
description of EPSON Photo!4.

❏ Chapter 4 explains how to prepare images, 
audio recordings, and video clips for uploading 
to your EPSON digital camera. It also includes 
information on printing your photos and 
combining your photos to create a panorama 
image.

❏ Chapter 5 explains how to solve problems you 
may encounter while using the software.

Finding More Information

Online help also provides information about EPSON 
Photo!4 settings and information on using EPSON 
AutoDownloader.

The online EPSON PhotoQuicker User’s Guide 
contains information on using EPSON PhotoQuicker 
to print your photos.

To set up and use the digital camera, see the user’s 
guide for your camera.
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System Requirements

To connect the PhotoPC 3100Z digital camera to your 
computer and run the digital camera software, refer 
to this section for the system requirements.

For Windows

The system requirements for Windows computers 
when connecting the PhotoPC 3100Z with a USB cable 
are as follows:

For Macintosh

The system requirements for Macintosh computers 
when connecting the PhotoPC 3100Z with a USB cable 
are as follows:

Note:
The included software cannot be used with the Multiple 
Users function of Mac OS 9.

486 processor or higher

USB port (TYPE A receptacle)

At least 48 MB RAM 
(64 MB when using EPSON PhotoQuicker)

Hard disk drive with at least 50 MB of free space
(170 MB when using EPSON PhotoQuicker)

VGA monitor with at least 256-color display

Microsoft® Windows 98 pre-installed, Windows 
Millennium Edition, or Windows 2000 pre-installed

QuickTime 4.1.2 or later

Power PC G3 processor or higher

Apple Macintosh with built-in USB port

48 MB RAM 
(128 MB when using EPSON PhotoQuicker together 
with EPSON Photo!4)

Hard disk drive with at least 50 MB free space
(170 MB when using EPSON PhotoQuicker)

Monitor with a minimum resolution of 640 × 480

Macintosh OS 8.5.1 to OS 9.1
(Panorama Stitcher Light EP requires 
Macintosh OS 8.6 to OS 9.1)

QuickTime 4.1.2 or later
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Warnings, Cautions, and Notes

 

w Warnings must be followed carefully to avoid bodily 
injury.

 

c Cautions must be observed to avoid damage to your 
equipment.

Notes contain important information and useful tips on the 
operation of your software, camera, and options.
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The Camera Software CD-ROM that comes with your 
PhotoPC 3100Z digital camera contains the following 
EPSON software.

❏ PhotoPC 3100Z USB driver
Driver necessary to connect your camera to your 
computer (except for Windows 2000 and 
Macintosh OS 9 users). 

❏ EPSON Photo!4
Software for viewing and managing the images 
you capture with your PhotoPC 3100Z.

❏ EPSON CameraStarter
Utility that starts automatically when you connect 
your camera to your computer and provides you 
with a convenient way to launch EPSON 
AutoDownloader and EPSON PhotoQuicker.
(Automatically installed with EPSON Photo!4.

❏ EPSON AutoDownloader
Utility that provides you with a quick and 
organized way to transfer your photos, video 
clips, and audio recordings from the camera to 
your computer.
(Automatically installed with EPSON Photo!4.)

❏ EPSON CardMonitor
Utility that enables EPSON CameraStarter to start 
automatically by detecting when the camera is 
connected to your computer, or when the 
memory card is inserted into a PC Card slot.

❏ EPSON PhotoQuicker
Software for printing your images.

❏ Panorama Stitcher Light EP
Software for creating panoramas by combining 
overlapping images, especially those taken using 
your PhotoPC 3100Z’s stitch assist feature.

❏ EPSON File Converter
Software for converting files so that they can be 
uploaded (with EPSON Photo!4) and used on 
your camera.

❏ QuickTime 4
Software necessary for viewing video clips.

❏ Adobe Acrobat Reader
Software for viewing the PDF online manuals 
contained in the Camera Software CD-ROM.
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Installing the Software for Windows Users

Follow the steps below to install the software on the 
included PhotoPC 3100Z Camera Software CD-ROM.

Note:
Do not connect your camera to your computer before you 
install the software.

1. Turn on the computer and insert the included 
Camera Software CD into the CD-ROM drive.

If a dialog box prompts you to select a language, 
click the appropriate language, then click .

2. The EPSON Installation Program dialog box 
appears. Select Install Digital Camera Software, 
then click .

Note:
If the EPSON Installation Program dialog box does not 
appear, double-click the My Computer icon. Click 
the CD-ROM icon, then select Open from the File 
menu. Then double-click Setup.exe.

3. The following dialog box containing a list of 
software appears.

Software with a check mark next to it will be 
installed on your PC in the order listed. Click a 
software title in the list to remove or add a check 
mark.

Note:
❏ Be sure to install all the software when installing 

software for the first time.

❏ EPSON AutoDownloader and EPSON 
CameraStarter are automatically installed when 
you install EPSON Photo!4.

❏ For a short description of each software, see page 
11.
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Note for Windows 2000 users:
The PhotoPC 3100Z uses the USB driver included 
with Windows 2000. Therefore, EPSON PhotoPC 
3100Z storage driver does not appear in the list of 
software and does not need to be installed.

4. Click OK, then follow the on-screen instructions. 

5. After installing the first software, click Finish. The 
installation process begins automatically for the 
next software that you selected in step 3.

6. Follow the on-screen instructions until all the 
software are installed.

7. When you finish installing the last software, the 
following dialog box is displayed.

Click OK, then restart your computer.

Note:
Be sure to restart your computer after you are finished 
installing software from the Camera Software CD-ROM.

Installing the Software for Macintosh Users

Follow the steps in the sections below to install the 
software on the included PhotoPC 3100Z Camera 
Software CD-ROM.

Installing EPSON Photo!4 and other software

1. Turn on the computer and insert the included 
Camera Software CD into the CD-ROM drive.

2. In the EPSON folder that appears on your 
computer’s desktop, double-click the icon of your 
preferred language. 

Note:
If the EPSON folder does not appear on your desktop, 
double-click the EPSON icon on your desktop. 
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3. Double-click the Installer icon. The following 
dialog box appears with a list of the software that 
will be installed.

Note:
❏ EPSON AutoDownloader and EPSON 

CameraStarter are automatically installed when 
you install EPSON Photo!4.

❏ Be sure to install all the software when installing 
software for the first time.

❏ On the Macintosh OS 9, the USB driver is not 
installed. The PhotoPC 3100Z uses the USB 
driver included in Mac OS 9.

4. To begin installing the software, click the Start 
button. Follow the on-screen instructions.

Note for Macintosh OS 8.5.x users:
Panorama Stitcher Light EP is not available and will 
not be installed.

5. After you finish installing the software, the 
following message appears.

Click Restart to restart your computer.

Note:
Be sure to restart your computer after you are finished 
installing software.
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After your computer restarts, go to the next 
section to install QuickTime 4. 

Installing QuickTime 4

QuickTime 4 is necessary for viewing video clips 
taken with your PhotoPC 3100Z on your computer. 
Follow the steps below to install QuickTime 4.

Note:
If QuickTime 4.1.2 or later is already installed on your 
computer, skip to the next section to install Acrobat 
Reader.

1. Turn on the computer and insert the included CD 
in the CD-ROM drive.

2. In the EPSON folder that appears on your 
computer’s desktop, double-click the icon of your 
preferred language. 

Note:
If the EPSON folder does not appear on your desktop, 
double-click the EPSON icon on your desktop. 

3. Double-click the QuickTime folder, then 
double-click the QuickTime Installer icon.

4. Follow the on-screen instructions.

Installing Acrobat Reader

Acrobat Reader is necessary for viewing the online 
EPSON Digital Camera Software Users Guide. Follow the 
steps below to install Acrobat Reader.

Note:
If Acrobat Reader is already installed on your 
computer, skip to the next section to set up EPSON 
CameraStarter.

1. Turn on the computer and insert the included CD 
in the CD-ROM drive.

2. In the EPSON folder that appears on your 
computer’s desktop, double-click the English 
icon.

Note:
If the EPSON folder does not appear on your desktop, 
double-click the EPSON icon on your desktop. 

3. Double-click the Manual folder.

4. Double-click the AcrobatReader folder. Then 
double-click the Acrobat Installer icon.

5. Follow the on-screen instructions.
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After you finish installation, go to the next section to 
set up EPSON CameraStarter.

Setting Up EPSON CameraStarter

EPSON CameraStarter is a utility that provides you 
with a convenient way to launch the EPSON 
AutoDownloader and EPSON PhotoQuicker 
software. You can then use these software to transfer 
files from your memory card to a computer, to print 
your images, or to do both in one session.

You can set up EPSON CameraStarter to open 
automatically when you connect your camera to your 
computer, or when you insert the card into a PC Card 
slot. To make these settings, follow the steps below.

Note:
❏ You must use the memory card with your PhotoPC 

3100Z before inserting it into a PC Card slot if you 
want EPSON CameraStarter to open automatically.

❏ To start CameraStarter automatically when a memory 
card is inserted, CardMonitor must be installed. For 
instructions on installing CardMonitor, see 
“Installing the Software for Windows Users” on page 
12 or “Installing the Software for Macintosh Users” 
on page 13.

1. Start EPSON CameraStarter.

In Windows
Click Start, point to Programs, then to EPSON 
Camera and then to EPSON Photo!4, then click 
EPSON CameraStarter.

On a Macintosh
Double-click the EPSON Photo!4 folder, then 
double-click the EPSON CameraStarter icon.

The EPSON CameraStarter dialog box appears.

2. Click the Settings button.

3. To make EPSON CameraStarter open 
automatically when you connect a PhotoPC 
3100Z containing a memory to your computer, or 
when you insert your memory card into your 
EPSON printer’s PC Card slot, click the Show 
EPSON CameraStarter button.

If you want CameraStarter to open automatically 
when you insert your memory card into a PC 
Card slot of a device other than your printer, such 
as your computer or a memory card reader, select 
the Monitor card insertion into Card Reader 
slots check box.
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Note:
Never insert or remove a memory card from your 
camera while the camera is on. For instructions on 
connecting your camera to your computer, see 
“Connecting the camera to your computer” on page 19.

If you do not want EPSON CameraStarter to open 
automatically, click the Ignore the Event button.

4. Click OK, then click Exit.

Note:
The Settings button is unavailable if EPSON 
CardMonitor is not installed.
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You can transfer your photos, video clips, and audio 
recordings from your memory card to your computer 
in a variety of ways when your PhotoPC 3100Z is 
connected to your computer, or when the memory 
card is in a PC Card slot of a device such as your 
EPSON printer or memory card reader. This chapter 
explains how to transfer your files and covers the 
following:

❏ How to connect the camera to your computer

❏ How to transfer files to your computer using 
EPSON AutoDownloader

❏ How to copy files to your computer using EPSON 
Photo!4

Connecting and Disconnecting the 
Camera

Use the included USB cable to connect the camera to 
the computer with the USB cable. When you camera 
is connected, you can download or copy your photo 
files to the computer, or upload photo files saved in 
the computer to the memory card. 

Connecting the camera to your computer

You can connect your PhotoPC 3100Z to a Windows 
or Macintosh computer using the included USB cable. 

Before connecting your camera, make sure that the 
USB driver is installed in your computer (except for 
Windows 2000 and Macintosh OS 9). For installation 
instructions, see “Installing the Software for Windows 
Users” on page 12 or “Installing the Software for 
Macintosh Users” on page 13.
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Note:
❏ Make sure the camera’s batteries have enough power 

whenever connecting the camera to your computer. If 
the PhotoPC 3100Z turns off automatically because of 
low battery power while connected, your computer 
may function improperly. EPSON highly recommends 
using the optional AC adapter whenever you connect 
the camera to your computer.

❏ When the camera is connected to the computer, you 
cannot use the buttons on the camera, and the camera’s 
automatic power save feature is disabled.

❏ Although you can connect USB cable at any time, 
EPSON recommends connecting it in the manner 
described below to secure the connection.

❏ If the EPSON software does not recognize the camera 
when it is connected, see the Troubleshooting chapter 
in the online EPSON Digital Camera Software User’s 
Guide included on your CD-ROM.

 To connect the camera, follow the steps below.

1. Turn on your computer.

2. Plug the cable connector into the USB port on your 
computer or USB hub.

 

c Caution:
Be sure to use the USB cable that comes with 
your camera to avoid damaging the camera’s 
interface connector.

USB port on 
computer

USB cable
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3. Open the connector cover on the side of the 
camera. Insert the other end of the USB cable into 
the interface connector. Make sure that the shape 
of the cable connector corresponds to the shape of 
the interface connector.

 

c Caution:
Be sure to position the cable correctly before 
inserting it into the connector. Otherwise, the 
cable and connector may be damaged.

4. Set the camera’s dial switch to  and turn the 
camera on.

The first time you connect your camera to your 
computer, the computer may display some windows 
while it associates the USB driver to the camera. This 
is normal and only happens the first time the camera 
is connected.

If you have not yet installed the USB driver, a message 
asking you to locate the driver will appear. If this 
happens, cancel the operation and disconnect the 
camera from the computer. Close all applications, then 
install the USB driver following the instructions in 
Windows 2000). For installation instructions, see 
“Installing the Software for Windows Users” on page 
12 or “Installing the Software for Macintosh Users” on 
page 13.

When you connect the camera, the green indicator 
light next to the viewfinder blinks while the 
connection is being established. While the camera is 
connected, stars move across the display panel at the 
top of the camera.

 

c Caution:
Keep your camera and computer away from potential 
sources of electromagnetic interference, such as 
loudspeakers or the base units of cordless telephones.

Disconnecting the camera from your computer

After you are finished using the camera with the 
computer, be sure to disconnect the camera properly. 
Follow the steps in the appropriate section below.

connector cover
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c Caution:
Be sure to follow these steps when disconnecting the 
camera. Doing otherwise may damage the camera or 
memory card, and could cause your computer to 
function improperly.

Disconnecting the camera in Windows Me and 98

1. Double-click the My Computer icon on the 
desktop. The My Computer window appears.

2. Right-click the Removable Disk icon, then click 
Eject.

3. Remove the USB cable, or turn off the camera.

Disconnecting the camera in Windows 2000

1. Double-click the eject icon on the task bar.

The Unplug or Eject Hardware dialog box 
appears.

Note:
You can also right-click the eject icon on the task bar, 
then click Unplug or eject hardware to display the 
Unplug or Eject Hardware dialog box.

2. Click the Stop button. The Stop a Hardware 
device dialog box appears.

3. Select USB Mass Storage Device, then click the 
OK button. 

4. A confirmation message appears. Click OK.

Note:
If the Problem Ejecting USB Mass Storage Device 
window appears, click the OK button and redo the 
operation from step 1.

5. Remove the USB cable, or turn off the camera.

Note:
You can also disconnect the camera by clicking the eject icon 
on the task bar once, then clicking Stop USB Mass 
Storage Device, and clicking OK.

Disconnecting the camera from a Macintosh

1. On the desktop, move the EPSON_DSC icon into 
the Trash.

the eject icon
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2. Remove the USB cable, or turn off the camera.

Using EPSON AutoDownloader to Transfer 
Images

EPSON AutoDownloader is a utility that allows you 
to quickly download photos, audio recordings, and 
video clips from your camera to a designated folder 
on your computer. 

This utility gives you complete control over the 
download process, helping you to organize and 
manage your files. It allows you to do the following 
tasks:

❏ Designate the location and name of a base folder 
to which your files will be downloaded.

❏ Download to subfolders within the base folder, 
and have the subfolders automatically named by 
the date of the download session or the date that 
the photos were taken.

❏ Automatically name files during download. You 
can choose to name them using the EPSON photo 
file format, using the date and time that they were 
taken, or using the date and sequence in which 
they were taken.

Once the files are downloaded to your computer, you 
can use EPSON Photo!4 to view and manage your 
images. For instructions, see Chapter 3, “Using 
EPSON Photo!4.”

For more information on EPSON AutoDownloader, 
see EPSON AutoDownloader’s online help.

Using EPSON AutoDownloader in Windows

To open EPSON AutoDownloader in Windows, 
follow the steps below.

1. Make sure that your camera is connected to your 
computer, and that they are both turned on. If 
necessary, see “Connecting the camera to your 
computer” on page 19.

2. Click Start, point to Programs, then to EPSON 
Camera and then to EPSON Photo!4, then click 
EPSON AutoDownloader. The main download 
dialog box appears.

3. To begin downloading, click the Start button.

To make download settings, click the Settings 
button. You can make settings on the Files and 
Folders and Advanced menus.
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Note:
❏ For more information on making settings, click the 

Help button.

❏ To make settings before opening the main 
download dialog box, click the Start button, point 
to Programs, then to EPSON Camera and 
then to EPSON Photo!4, then click EPSON 
AutoDownloader Settings.

Using EPSON AutoDownloader on a Macintosh

To access EPSON AutoDownloader using a 
Macintosh, follow the steps below.

1. Make sure that your camera is connected to your 
computer, and that they are both turned on. If 
necessary, see “Connecting the camera to your 
computer” on page 19.

2. Double-click the EPSON Photo!4 folder, then 
double-click the EPSON AutoDownloader icon. 
The main download dialog box appears.

3. To begin downloading, click the Start button.

To make download settings, click the Settings 
button. You can make settings on the Files and 
Folders and Advanced menus.

Note:
❏ For more information on making settings, click the 

Help button.

❏ To make settings before opening the main 
download dialog box, double-click the EPSON 
Photo!4 folder and then the EPSON 
AutoDownloader Settings icon.

Accessing EPSON AutoDownloader from EPSON 
CameraStarter

You can also access EPSON AutoDownloader from 
the EPSON CameraStarter utility. Follow the steps 
below. 

1. Start EPSON CameraStarter.

In Windows
Click Start, point to Programs, then to EPSON 
Camera and then to EPSON Photo!4, then click 
EPSON CameraStarter.

On a Macintosh
Double-click the EPSON Photo!4 folder, then 
double-click the EPSON CameraStarter icon.

The EPSON CameraStarter dialog box appears.
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2. To open EPSON AutoDownloader, click one of 
the following icons.

❏ The  SAVE icon
Click this icon when you want to transfer files 
from your memory card to your computer.

❏ The  SAVE & PRINT icon
Click this icon when you want to transfer files 
from your memory card to your computer, 
then print them using EPSON PhotoQuicker.

The main dialog box of EPSON AutoDownloader 
appears.

Note:
❏ To use the SAVE & PRINT icon, EPSON 

PhotoQuicker must be installed in your computer. 
For installation directions, see “Installing the 
Software for Windows Users” on page 12 or 
“Installing the Software for Windows Users” on 
page 12.

❏ If you click the SAVE & PRINT icon, EPSON 
PhotoQuicker software will start automatically 
after the files are finished being transferred to your 
computer, regardless of the settings you make in 
EPSON AutoDownloader.

❏ You can make settings to have EPSON 
CameraStarter start automatically. For details, 
see “Setting Up EPSON CameraStarter” on page 
16.

3. To begin downloading, click the Start button.

To change download settings, click the Settings 
button. You can make settings on the Files and 
Folders and Advanced menus.

Note:
For more information on making settings, click the 
Help button.
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EPSON Photo!4 helps you view and manage the image 
and audio recording files saved on your camera’s 
memory card or in your computer. You can use 
Photo!4 to organize your files, view your photos in a 
variety of ways, and play back audio recordings and 
video clips. EPSON Photo!4 also allows you to upload 
EPSON Photo file format images to your camera’s 
memory card, prepare your files to be sent over the 
Internet via e-mail, and use your images as a 
background for your desktop.

This chapter describes how to use Photo!4, including 
the procedures for erasing images from the camera 
and for uploading EPSON Photo file format images to 
your camera.

Note:
See online help for more information on using EPSON 
Photo!4. To open help, click the  icon in EPSON Photo!4.

Starting EPSON Photo!4

Follow the instructions in this section to open EPSON 
Photo!4.

For Windows users

Click Start, point to Programs, then to EPSON 
Camera and then to EPSON Photo!4, then click 
EPSON Photo!4. The main window of EPSON 
Photo!4 appears.

For Macintosh users

Double-click the EPSON Photo!4 icon in the EPSON 
Photo!4 program group or folder. The main window 
of EPSON Photo!4 appears.



Using EPSON Photo!4 28

Viewing Your Images

EPSON Photo!4 includes many features for viewing 
images on the camera’s memory card, or images that 
have been imported from the camera to the computer. 
You can display thumbnail images of your images or 
video clips, or display a list that shows more 
information regarding the images. You can also 
display a larger image or play back video clips with 
the Image Viewer window, watch a slideshow of your 
images, and play back audio clips. Use the Photo!4 
search function to find files according to file name, 
date taken, or other guidelines that you can choose.

Selecting folders and drives containing images

The EPSON Photo!4 main window is divided into a 
left and right pane. The left pane shows a list of your 
drives and folders, and the right pane shows 
thumbnails or a list of the EPSON Photo file format 
image files in a selected folder or drive. 

Click or double-click a drive or folder to view its 
contents.

Note:
❏ If no EPSON Photo file format image files are in the 

selected folder, No Images appears in the right pane.

❏ Only EPSON Photo file format image files are 
displayed in the right pane.

❏ To update the contents of the left pane, select Refresh 
from the View menu. Folders and drives that were 
recently moved, renamed, or added to your computer 
will be displayed in the left pane.

To view all the folders and drives accessible from your 
computer, click All Folders at the top of the left pane.

To display only folders that contain images, click 
Image Folders at the top of the left pane. Only the 
following folders are displayed:

❏  Base Folder 
You can change the name or location of this folder 
by selecting Settings from the Edit menu, then 
specifying a new folder in the Base Folder list box.

❏  EPSON Camera
This drive appears only when the memory card is 
in your PhotoPC 3100Z and the camera is 
properly connected to your computer.

❏  Camera Card
This drive appears when the memory card is 
inserted into the PC Card slot of another device, 
such as your EPSON printer or a memory card 
reader.
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❏  Recent Search Results
This folder contains the results of your most 
recent searches using the EPSON Photo!4 search 
function. To use this function, see “Displaying 
thumbnail images or a list of files” on page 29.

Image files in memory cards are located in the 
following folders:

❏ 100EPSON
This folder is inside the DCIM folder and contains 
photo files. These files end with either the JPG or 
TIF extension. 

❏ MOVIE
This folder contains movie clip files that end with 
the MOV extension.

Displaying thumbnail images or a list of files

You can display images in the right pane as 
thumbnails of various sizes or as a list of files. Click 
the following buttons in EPSON Photo!4 to switch the 
view.

You can reverse the order that the images or files 
appear by clicking the arrow icon at the upper right 
corner of the right pane. When viewing a list of files, 
you can change the order in which the files appear by 
clicking an item at the top of the right pane.

Note:
Audio recording files are not displayed. See “Playing back 
audio recordings” on page 34 to play back recordings 
associated with a photo.

Click this button... To display...

Large Thumbnails

Medium Thumbnails (Default)

Small Thumbnails

Details
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Selecting images

Click an image file to select it. You can select a group 
of images by dragging the cursor over them, or by 
clicking the images while holding down the Shift key 
on your keyboard. You can also select multiple images 
by holding down the Ctrl key (Windows) or Option 
key (Macintosh) while clicking the images.

To select all the files in the selected folder or drive, 
click the  button, or click Select All on the Edit 
menu.

Viewing image information

EPSON Photo!4 allows you to view information about 
image files in a variety of ways. You can display 
information icons in the margins of thumbnails, show 
or hide a variety of file details at the top of a list of files, 
and access all the available information on a selected 
image by using the Properties dialog box. The 
following sections explain how. 

Note:
The following information is not displayed for video clips: 
image quality; file format symbols; and stitching 
information.

Displaying information in thumbnails

You can display information icons on the left side of 
the thumbnails by clicking the  icon, or by selecting 
Image Info from the View menu. The information 
icons indicate the type of image file and the settings 
used when the image was captured, as explained 
below.

❏ File format icons:
 appears if the image is a JPEG file that conforms 

to the “Design rule for camera file system,” the 
standard recording system for image files. 

 appears for images that are uncompressed 
TIFF files.

 appears if the file is a video clip.

❏ Image quality icons: 
 appears for HyPict,  for super-fine,  for 

fine, or  for standard.

❏  appears if the photo is locked.

❏ Stitching icons:
 appears if the photo is the first in a series of 

photos taken using the PhotoPC 3100Z’s stitch 
assist function.

 appears if the photo was taken using the 
PhotoPC 3100Z’s stitch assist function, but was 
not the first photo taken in the series.
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❏ Audio recording icon: 
 appears if the photo has an associated audio 

recording. Click this icon to play back the 
recording.

You can also display other image information at the 
bottom of the thumbnail. From the View menu, select 
Image Title, then click the items described below to 
show or hide that information. A check mark appears 
next to items that are currently being displayed.

❏ Filename
Click to show or hide the name of the image file.

❏ Date Taken
Click to show or hide the date and time that the 
image was taken.

❏ Stitching Location
Click to show or hide information about the 
location of the photo in a series of photos taken 
with the PhotoPC 3100Z’s stitch assist feature. No 
information is shown for images that were taken 
without using the stitch assist feature.

❏ Image Number
Click to show or hide the number that EPSON 
Photo!4 assigns to each image.

Note:
If there is not enough room to display all of the information 
at the bottom of the thumbnail, switch to a larger thumbnail 
view by clicking the  or  buttons. 

Displaying information in a list of files

When viewing a list of files in the right pane of the 
main window, you can specify what information is 
displayed for each file in the list. 

Note:
To display a list of files, see “Displaying thumbnail images 
or a list of files” on page 29.

Showing and hiding file format information

To display a symbol that indicates the format of the 
file, click the  button. The following symbols 
appear.

 appears if the image is a JPEG file that 
conforms to the “Design rule for camera file 
system,” the standard recording system for image 
files. 

 appears for images that are uncompressed 
TIFF files.

 appears if the file is a video clip.

Click the  button to hide this information. 
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Showing and hiding information fields

You can specify what information fields are shown in 
the file list by using the Details View menu in the 
Settings dialog box. 

To change which items are shown or hidden, follow 
the steps below.

Note:
See the online help for details on the available information 
fields.

1. From the Edit menu, select Settings.

2. Click the Details View tab to display the Details 
View menu.

3. Use the Available Fields and Displayed Fields 
boxes to arrange the items you want to show or 
hide.

Click the  and  buttons to move selected 
items between the Available Fields and Displayed 
Fields boxes.

Click the  and  buttons to change the order 
of selected items in the Displayed Fields box.

4. You can return all the items to their original 
positions by clicking the Default button.

5. Once you are satisfied with your settings, click OK 
to save them.

Using the Properties dialog box

The Properties dialog box allows you to view all 
available information on your image files at once. You 
can also create or modify the user comment for a 
selected image in this box. Follow the steps below.

1. Select Properties from the File menu. The 
Properties dialog box appears.
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2. Click a thumbnail or file in the right pane. 
Information about that image appears in the 
Properties dialog box.

Note:
If you select multiple images, only the number of 
selected images and the total file size in KB and bytes 
is displayed.

Click the minus (-) and plus (+) signs on the right 
side of the dialog box to hide and show the 
information in that section.

To create or modify a user comment for a selected 
image, click the Edit Comment button, type your 
text in the text box, then click the OK button to 
save your changes.

Note:
The user comment function is only available for images 
taken with the PhotoPC 3100Z.

3. With the Properties dialog box still open, click a 
different image to view properties for that image.

You can also select multiple images to view the 
total file size for the selected group of images.

4. Click Close to close the Properties dialog box.

Viewing photos in the Image Viewer window

The Image Viewer window allows you to view 
enlarged versions of photos and to play back video 
clips. You can open more than one Image Viewer 
window at a time.

minus signs



Using EPSON Photo!4 34

To open an Image Viewer window, double-click a 
thumbnail or file in the right pane of the main 
window. You can also click the  button to open one 
or more selected images. If you selected multiple 
images, thumbnails of those images appear in the left 
side of the window.

Use the buttons in the Image Viewer window to view 
your images, as explained in the table below.

Note:
You need to have QuickTime 4.1.2 or later installed in your 
computer to play back video clips. 

Playing back audio recordings

If a photo has an associated audio recording, you can 
play the recording back by selecting the photo and 
clicking the  button, or by selecting Audio 
Recording from the Image menu, then clicking Play. 
To stop the playback, click the  button again. 

Playing back video clips

To play back a video clip, double-click its thumbnail 
or file, or click the thumbnail or file to select it, then 
click the  button. The first frame of the clip is 
displayed in the Image Viewer window. Use the 
controls to play back your clip.

Use this button... To...

View the previous image.
This button is not available when the 
first image is being viewed.

View the next image.
This button is not available when the 
last image is being viewed.

Open another Image Viewer window.

Fit the size of the image to the window.

Show the image in its original size.

Zoom in on the image.

Zoom out.

Rotate the image 90 degrees to the 
left.

Rotate the image 90 degrees to the 
right.

Display thumbnails of selected 
images, or all the images in the 
selected folder or drive.

Hide the thumbnails.

Use this button... To...
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Note:
❏ You need to have QuickTime 4.1.2 or later installed in 

your computer to play back video clips. 

❏ For details on using the Image Viewer window, see 
“Viewing photos in the Image Viewer window” on 
page 33.

Viewing a slide show

EPSON Photo!4 allows you view slide shows of 
selected photos.

See the next sections to make slide show settings and 
run slide shows. 

Making slide show settings

To make settings for your slide shows, follow the steps 
below.

1. From the Edit menu, select Settings.

2. Click the Slideshow tab to display the Slideshow 
menu.

3. Make the Picture size settings. 

Click Original Size to display images without 
modifying their size.

Click Fit to Screen to modify the size of each 
image so that it fits the size of your monitor. To 
display images that are smaller than your monitor 
without modifying their size, select the Original 
Size for Small Pictures check box.

4. Make Playback Control settings.

To advance each photo automatically, select Auto 
Advance. Specify the interval between the 
photos by typing a value in the Interval box or by 
moving the slider below the box.

To repeat the slide show automatically, select 
Repeat.

To play back audio recordings along with the 
photos, select Play Audio Recording.

If you want to display the slide show Control 
Panel when the slide show starts, select the Show 
Control Panel check box.

Note:
When the Play Audio Recording check box is 
selected, the photo will not automatically advance until 
the recording has finished playing, regardless of the 
setting in the Interval box.
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5. In the Picture Title box, select the image 
information you want to appear during the slide 
show.

Show Filename, Show User Comment, and 
Show Date and Time are all selected as the 
default setting.

6. Click OK to save your settings, or click the 
Default button to return all the items to their 
original settings.

Go to the next section to start your slide show.

Running a slide show

To start and control a slide show, follow the steps 
below.

Note:
❏ You can view only the first frame of a video clip during 

the slide show. You cannot play back the clip.

❏ Images are shown in the order they appear when 
selected in the right pane of the main window.

1. Select the images you want to include in the slide 
show. If one or no images are selected, all files 
displayed in the right pane will be included in the 
slide show. 

2. From the Image menu, select Slideshow. The slide 
show begins.

You can advance to the next image by clicking 
your mouse button.

3. You can control the slide show by clicking the 
buttons in the control panel.

See below for an explanation on using the buttons 
in the control panel.

Button Function

Click to show the previous image. 
Not available when the first image of the 
slide show is displayed.

Click to show the next image. 
Not available when the last image of the 
slide show is displayed.

Click to play the associated audio 
recording. 
Not available for photos with no 
recording, or for video clips.

Click to pause the slide show.

Click to resume playing the slide show.

control panel 
for slideshows
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If the Control Panel does not appear when the 
slide show starts, press the Esc key on your 
keyboard to display the panel. Press the Esc key 
again to hide the panel.

Using the search function

EPSON Photo!4 provides a powerful search function 
to help locate your image files. Follows steps below to 
use the search function.

1. Select the folder to be searched in the left pane.

2. From the File menu, select Search. The Search 
dialog box appears.

3. If you also want to search subfolders, put a check 
in the Search Subfolders check box.

4. To further narrow your search, make settings in 
the fields under Search By. See online help for 
details on using these fields.

Note:
Images that meet all of the conditions you specify will 
be found.

If you select the Remember These Search 
Conditions check box, the settings you made in 
the fields under Search By are saved. The next 
time you open the Search dialog box, those search 
settings are automatically made.

If you click the Reset button, the fields under 
Search By return to their default settings.

After clicking Search, the Recent Search Results 
folder is selected in the left pane and any images 
that are found are displayed in the right pane. If 
no images are found, No Images appears.

Managing Your Images

EPSON Photo!4 includes many convenient features 
for managing your images. In addition to changing a 
file’s name, you can also lock important files to protect 
them from being accidentally deleted and upload files 
to a memory card. EPSON Photo!4 also includes 
functions for adding comments to files, rotating 
images, and sending files via e-mail.

Click to exit the slide show and return to 
the main window.

Button Function
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Locking and unlocking files

You can lock files to prevent them from accidentally 
being modified or erased. To lock or unlock files, 
follow the steps below.

Note:
Locking or unlocking a photo that has an audio recording 
also locks or unlocks the recording.

1. Select an image or images in the right pane of the 
main window.

2. Select Lock from the Image menu to lock the 
images. Select Unlock to unlock them.

Changing file or folder names

To change the name of a file, follow the steps below.

Note:
❏ You cannot change the names of drives using EPSON 

Photo!4.

❏ When you change the name of a photo file that has an 
associated audio file, the name of the associated audio 
file also changes to the same name.

1. Select the file or folder whose name you want to 
change.

2. From the File menu, select Rename. The Rename 
dialog box appears.

3. Type a new file or folder name, then click the OK 
button.

Deleting files

To delete one or more files, follow the steps below.

1. Select an image or images in the right pane of the 
main window.

2. From the File menu, select Delete. A message 
appears asking you to confirm the deletion.

3. Click Yes to delete the selected images; click No 
to cancel the operation.

Moving and copying files

You can use the drag-and-drop method to move or 
copy files by dragging the image in the right pane to 
a folder in the left pane.

Moving files

1. Select an image or images in the right pane of the 
main window.
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2. To move the image to another folder in the same 
drive, drag the image to the folder in the left pane.

To move the image to a folder in a different drive, 
drag the image to the folder in the left pane while 
holding down the Shift key (for Windows), or the 
Ctrl key (for Macintosh).

Copying files

1. Select an image or images in the right pane of the 
main window.

2. To copy the image to another folder in the same 
drive, drag the image to the folder in the left pane 
while holding down the Ctrl key (for Windows), 
or the Option key (for Macintosh).

To copy the image to a folder in different drive, 
drag the image to the folder in the left pane.

Uploading files to a memory card

You can use EPSON Photo!4 to upload images from 
your computer to a memory card inserted in your 
camera or other device’s PC Card slot. 

Once your camera or other device is connected to your 
computer, select the images you want to upload, the 
select Upload from the File menu. Then select the 
drive with the memory card and click the OK button 
to upload the files. 

If any of the photos that you select to upload have 
audio recordings attached, you can choose to upload 
both the photos and audio recording files, or just the 
photos.

Note:
Files that were not originally downloaded from the camera 
and that have not been converted to EPSON Photo file 
format cannot be uploaded using this feature. For 
instructions on converting files to EPSON Photo file 
format, see “Using EPSON File Converter” on page 48.

Adding user comments

You can add comments to photos and video clips 
taken with your PhotoPC 3100Z. User comments are 
useful for recording personal notes and other 
additional information about your images.
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You can have your comments appear in slide shows, 
in the Properties dialog box, and in the right pane of 
the main window when viewing a list of files. You can 
also use EPSON Photo!4’s search function to find 
images based on the text you added in the user 
comments. 

Note:
❏ You can only add comments to images taken with the 

PhotoPC 3100Z.

❏ To display user comments in a list of files, see 
“Displaying thumbnail images or a list of files” on page 
29.

❏ To include comments in a slide show, see “Making slide 
show settings” on page 35.

❏ For information on using EPSON Photo!4’s search 
function, see “Displaying thumbnail images or a list of 
files” on page 29.

Follow the steps below to create or modify a user 
comment.

1. Select an image in the right pane. 

2. From the Image menu, select Edit Comment. The 
Edit User Comment dialog box appears.

3. Type your comment in the text box, then click OK 
to save your comment.

You can modify user comments in the Properties 
dialog box. See “Using the Properties dialog box” on 
page 32 for details.

Rotating your photos

You can rotate photos clockwise or counterclockwise 
without decreasing the image quality. Select a 
thumbnail in the right frame of the main window and 
click the  button to rotate the image 90 degrees to 
the right, or the  button to rotate the image 90 
degrees to the left.

Note:
❏ You cannot rotate video clips. You cannot rotate photos 

that are locked.

❏ You can rotate JPEG and TIFF images taken by 
EPSON cameras. Images taken by cameras other than 
EPSON cameras cannot be rotated. 

❏ Photos in the camera drive or memory card drive 
cannot be rotated.

Using a photo as wallpaper

Follow the steps below to use an image as your 
computer’s desktop background.



Using EPSON Photo!4 41

1. Select a photo in the right pane of the main 
window.

2. From the Image menu, select Set as Wallpaper. 
The Set as Wallpaper dialog box appears.

3. Click Fit To Screen, Center, or Tile to specify the 
size and position of the image. You can see the 
results of your selection in the preview on the left 
side of the dialog box.

To remove an image that is currently being used 
as wallpaper, click Remove Wallpaper.

4. Click OK.

Sending files via e-mail

EPSON Photo!4 helps you prepare files for e-mail 
transmission quickly and easily. With the Send via 
E-mail feature, you can modify the file size, calculate 
the total amount of data to be sent, and attach files to 
an e-mail message using your favorite e-mail 
program. You can also save the prepared image 
instead of sending it right away.

Note:
Using EPSON Photo!4, you can attach files directly to 
e-mail messages. For a list of the e-mail applications you can 
use with this feature, see the README file for EPSON 
Photo!4. To send files using other e-mail programs, first 
save the images to your computer’s hard disk by using the 
Save button in step 5 below.

Follow these steps to prepare your images to send 
through e-mail.

1. Select an image or images in the right pane of the 
main window.

2. From the Image menu, select Send via E-mail. 
The Send via E-mail dialog box appears.

3. Select the check boxes of the items you want to 
send.

To send the photo files without reducing their 
size, click Send ’Original Size’ photos. 

To change the size of the photo files you send, 
click Send ’Reduced Size’ photos, then select a 
setting in the Photo Reduction Setting list box.
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When you click the Calculate button, the 
reduced size is automatically calculated. The 
calculated size is shown under File Size, and 
Estimated Total changes to Total. The Calculate 
button display changes to light gray and cannot 
be used. If you change the setting in the Photo 
Reduction Setting list box, the Calculate button 
is turned on again. Click the Calculate button 
again to calculate the reduced size of the new 
setting.

Note:
If you select Send ’Reduced Size’ Photos, a 
temporary file is created. The size of the temporary file 
is changed, and the temporary file is attached to the 
e-mail message.

4. If you are using a Macintosh, select the e-mail 
program you want to use from the Select E-mail 
Application Script list box.

Note:
If you are using Windows, use the e-mail program that 
is set for your regular use.

5. When you are satisfied with your settings, click 
the Send button, the Save & Send button, or the 
Save button.

Click the Send button to automatically attach the 
selected files to an e-mail message. The selected 
files are not saved to the computer’s hard disk.

Click the Save and Send button to automatically 
save the file or files to the computer’s hard disk so 
that you can later attach them to an e-mail 
message.

Click the Save button to save the selected files to 
the computer’s hard disk. The selected files are 
not attached to an e-mail message.

6. If you click the Send button in the previous step, 
an e-mail program opens. Use the program to 
send your message with the files attached.

7. If you clicked the Save or Save and Send button 
in step 6 above, specify a folder in which to save 
the files, then click OK. The files are saved in the 
specified folder for later use according to the 
settings you made.

If you clicked the Save and Send button, an 
e-mail program opens. Use the program to send 
your message with the files attached.
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Printing photos

You can use EPSON Photo!4 to select photos for 
printing, then to start EPSON PhotoQuicker to print 
the selected photos. Make sure that EPSON 
PhotoQuicker is installed on your computer. For 
installation instructions, see “Installing the Software 
for Windows Users” on page 12 or “Installing the 
Software for Macintosh Users” on page 13.

Note:
❏ You cannot print video clips.

❏ For instructions on printing with EPSON 
PhotoQuicker, see the software’s documentation.

Follow the steps below.

1. Select a photo or photos in the right pane of the 
main window.

2. From the File menu, select Print. EPSON 
PhotoQuicker starts. Use EPSON PhotoQuicker 
to print the photos.

Note for Macintosh users:
To start EPSON PhotoQuicker from within EPSON 
Photo!4, make sure that there is 128 MB of memory 
available in your system. To change the amount of 
available system memory on your Macintosh, see your 
computer’s documentation.
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Your camera comes with a number of utility programs 
in addition to EPSON Photo!4. This chapter tells you 
how to use these programs and covers the following 
topics:

❏ Using EPSON CameraStarter to start EPSON 
AutoDownloader or EPSON PhotoQuicker, in 
order to download or print photos in the PhotoPC 
3100Z’s memory card.

❏ Converting image and sound files to a compatible 
file format using EPSON File Converter, so that 
they can be uploaded to your camera’s memory 
card. Also, capturing screen shots of your 
computer desktop.

❏ Printing photos that are saved on your camera’s 
memory card, or that have already been saved on 
your hard disk, using EPSON PhotoQuicker.

❏ Combining photos that were taken with the 
camera’s Stitching function to create a panorama 
image, using EPSON Panorama Boutique Light.

Using EPSON CameraStarter

EPSON CameraStarter provides a convenient way to 
launch EPSON AutoDownloader and EPSON 
PhotoQuicker so that you can transfer files from your 
memory card to a computer, print your images, or do 
both in one session.

Note:
❏ For more information on using EPSON 

AutoDownloader, see “Using EPSON 
AutoDownloader to Transfer Images” on page 23. 

❏ For more information on using EPSON PhotoQuicker, 
see “Accessing EPSON PhotoQuicker” on page 59.

Follow the steps below to use EPSON CameraStarter. 

1. Connect the PhotoPC 3100Z to your computer as 
explained in “Connecting the camera to your 
computer” on page 19.

2. Start EPSON CameraStarter as described below.

For Windows Users
Click Start, point to Programs, then to EPSON 
Camera, then to EPSON Photo!4, and then click 
EPSON CameraStarter.
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For Macintosh Users
Double-click the EPSON Photo!4 folder, then 
double-click the EPSON CameraStarter icon.

Note:
EPSON CameraStarter may start automatically when 
you connect your camera, depending on the settings in 
the Settings dialog box. For more information, see 
“Setting Up EPSON CameraStarter” on page 16.

The EPSON CameraStarter dialog box appears.

3. Check the information that appears after Source 
Drive. 

If EPSON_DSC appears, CameraStarter detects 
your camera’s memory card. Go to the next step.

Note:
If you changed the name of your memory card, the new 
memory card name appears after Source Drive instead 
of EPSON_DSC. In this case, go to the next step.

If <Please Select> appears after Source Drive, 
CameraStarter detects more than one memory 
card, and you need to select the memory card 
whose images you want to access. Click the 
Select Drive button, then select a memory card 
from the list box and click OK.

If <None Found> appears after Source Drive, 
make sure the camera is properly connected to 
your computer and turned on, or the memory 
card is properly inserted in a PC Card slot. 
Then click the Select Drive button. When 
CameraStarter detects your memory card, 
EPSON_DSC appears after Source Drive.

4. Click one of the following icons to start the 
desired software.

 SAVE
Click this icon to start EPSON AutoDownloader 
in order to transfer files from your memory card 
to your computer.

printer icons

name of 
detected 
memory card
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 PRINT
Click this icon to start EPSON PhotoQuicker in 
order to print the images in the memory card. 

❏ When the printer icons are gray, EPSON 
PhotoQuicker loads all of the photos in the 
memory card.

❏ When the printer icons are green, a message 
appears asking whether you want to print 
according to the DPOF settings that you 
made. If you click OK, PhotoQuicker loads 
only photos for which the number of prints 
have been specified, or if an index setting has 
been made, PhotoQuicker loads all of the 
photos in the memory card.

 SAVE & PRINT
Click this icon to start EPSON AutoDownloader 
and EPSON PhotoQuicker in succession. After 
using EPSON AutoDownloader to transfer files 
from your memory card to your computer, 
EPSON PhotoQuicker automatically starts, 
allowing you to print your photos.

❏ When the printer icons are gray, EPSON 
PhotoQuicker loads all of the photos that 
were downloaded.

❏ When the printer icons are green, a message 
appears asking whether you want to print 
according to the DPOF settings that you 
made. If you click OK, PhotoQuicker loads 
only photos for which the number of prints 
have been specified, or if an index setting has 
been made, PhotoQuicker loads all of the 
downloaded photos.

Note:
Green printer icons in the EPSON CameraStarter 
dialog box indicate that a setting was made using the 
camera to specify the number of prints for one or more 
photos in the memory card, or that the index setting 
was set to On. 
Gray printer icons indicate that no print or index 
settings were made.
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Using EPSON File Converter

EPSON File Converter, which is included on the 
CD-ROM shipped with your camera, allows you to 
convert any JPEG or BMP image to the EPSON Photo 
file format so that it can be uploaded to the memory 
card in your camera. It will also allow you to convert 
any WAV or AIFF (for Macintosh only) audio 
recording file to the EPSON Photo file format for 
uploading to a memory card.

Windows users can also use this software to make and 
save “screen shots” of everything displayed on the 
computer screen. Use this feature to turn any of the 
documents that you create, for example PowerPoint 
presentations, into image files that you can upload to 
a memory card. Macintosh users can make screen 
shots using Macintosh system software.

Note:
You can upload files to your camera’s memory card using 
EPSON Photo!4. For information on uploading files, see 
“Uploading files to a memory card” on page 39.

To use EPSON File Converter, you must first install 
the program on your computer from the software 
CD-ROM included with your PhotoPC 3100Z. To 
install EPSON File Converter, follow the instructions 
in “Installing and Setting up the Software” on page 10.

Converting images in Windows

To convert images to the EPSON Photo file format so 
that they can be uploaded to the memory card in your 
camera, follow the steps below. To convert images 
using a Macintosh, see “Converting images on a 
Macintosh” on page 52.

1. To open EPSON File Converter, click Start, point 
to Programs, then to EPSON Camera and then 
to EPSON File Converter, then click EPSON File 
Converter. The Convert to the DCF file menu is 
displayed.
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2. From the Files Type list, select the current file 
format of the file that you want to convert. Then, 
using the Drive and Folder lists, specify which 
folder contains the images that you want to 
convert. Double-click the appropriate folder. The 
files in that folder that are available for converting 
are displayed in the File Name box.

Note:
To convert images that are saved on a network drive, 
you may need to map the drive before opening EPSON 
File Converter. See your Windows documentation for 
details.

3. Select an image that you want to convert from the 
File Name list. Then click the -> button. Repeat 
this procedure until all of the files that you want 
to convert are shown in the Selected Files List. If 
you want to convert all of the images in the File 
Name list, click the >> button.

To remove a file from the Selected Files List, click 
the <- button. To remove all of the files from this 
list, click the << button.

To change the order in which the files will be 
saved on your camera’s memory card when you 
upload them to your camera using EPSON 
Photo!4, select the image that you wish to move, 
then click the ↑  or ↓  Sort arrow.

Note:
To preview the selected image and confirm its size, 
select the Preview check box.

4. For each file that is displayed in the Selected Files 
List, select an image size from the Image Size box.

To convert and save the selected image at a size 
of 640 × 480 pixels, select 640 × 480.
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To have EPSON File Converter automatically 
assign an image size to the image when it is 
converted and saved, select Automatic. EPSON 
File Converter automatically chooses one of the 
three sizes listed below, selecting the size that 
most closely matches the size of the original 
image.

640 × 480 pixels
1600 × 1200 pixels
2048 × 1536 pixels

Note:
EPSON File Converter does not change the image size 
when converting images that were taken using the 
following EPSON cameras: PhotoPC 700, 750Z, 800, 
850Z, or 3000Z.

5. When you are ready to convert the files and save 
them on your computer, click the Start button, 
then specify the folder in which you want to save 
the files.

6. Click OK. The files are converted and saved to the 
specified folder.

Once you save the converted files to a folder in your 
computer, you can use EPSON Photo!4 to upload 
those files to the memory card in your camera. To 
upload the files, see “Uploading files to a memory 
card” on page 39. To convert audio files, see the next 
section.

Converting audio files in Windows

Follow the steps below to convert audio files and 
attach them to EPSON Photo file format images so that 
they can be uploaded to the memory card in your 
camera. To convert audio files using a Macintosh, see 
“Converting audio files on a Macintosh” on page 54.

1. To open EPSON File Converter, click Start, point 
to Programs, then to EPSON Camera and then 
to EPSON File Converter, then click EPSON File 
Converter. The Convert to the DCF file menu is 
displayed.

2. Select the image files that you wish to associate 
audio files with and add them to the Selected Files 
List. For more information about file selection, see 
“Converting images in Windows” on page 48.
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3. Select one of the image files in the Selected Files 
List to which you want to link an audio file.

4. Click Sound Select to specify the audio file that 
you wish to link to that image. Using the Look in 
list box, specify the drive on which the audio 
recording is saved, then double-click the 
appropriate folder. The files contained in that 
folder are displayed.

5. Select the audio recording file that you wish to use 
and click Open.

Note:
Click Play Sound to listen to the selected audio 
recording.

6. Repeat steps 3 to 5 to link more audio recordings 
to image files for uploading. A speaker icon is 
displayed to the left of the file names in the 
Selected Files List box for image files that have 
audio recordings attached.
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Note:
❏ To listen to an audio recording, select the image 

file to which it is attached and click Play Sound.

❏ To remove an attached audio file from an image 
file, select the image file and click Delete Sound. 

7. When you are ready to save the selected files on 
your computer, click the Start button, then specify 
the folder in which you want to save the files.

8. Click OK. The files are converted and saved in the 
specified folder.

You are now ready to upload the converted files to the 
memory card in your camera using EPSON Photo!4. 
For instructions on uploading your files, see 
“Uploading files to a memory card” on page 39.

Converting images on a Macintosh

To convert images to the EPSON Photo file format so 
that they can be uploaded to the memory card in your 
camera from your Macintosh, follow the steps below.

1. Double-click the EPSON File Converter icon in 
the EPSON File Converter program group or 
folder. The EPSON File Converter dialog box 
opens.
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2. Click Add. The Select Files dialog box appears. 
Double-click the folder which contains the images 
that you want to convert, then select one of the 
files that you want to convert and click Select. 
Repeat this procedure for each file that you want 
to convert.

3. When you finish selecting image files, click Done 
to close the Select Files dialog box. The selected 
images appear in the Selected File List box.

To remove a file from this list, select the file and 
click Remove.

To change the order in which the files will be 
saved on your camera’s memory card when you 
upload them to your camera using EPSON 
Photo!4, select the image that you wish to move, 
then click UP or DOWN.

Note:
To preview the selected image and confirm its size, 
select the Preview check box.

4. Specify an image size in the Image Size box for 
each file in the Selected File List.

To convert and save the selected image at a size 
of 640 × 480 pixels, select 640 × 480.

To have EPSON File Converter automatically 
assign an image size to the image when it is 
converted and saved, select Automatic. EPSON 
File Converter automatically chooses one of the 
three sizes listed below, selecting the size that 
most closely matches the size of the original 
image.

640 × 480 pixels
1600 × 1200 pixels
2048 × 1536 pixels
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Note:
EPSON File Converter does not change the image size 
when converting images that were taken using the 
following EPSON cameras: PhotoPC 700, 750Z, 800, 
850Z, or 3000Z.

5. When you are ready to save the selected files on 
your computer, click the Start button, then specify 
the folder in which you want to save the files. The 
name of the currently selected folder appears in 
quotations next to Select on the button at the 
bottom of the dialog box.

6. Click the Select button. The files are converted 
and saved in the specified folder.

To upload your files to the memory card in your 
camera using EPSON Photo!4, see “Uploading files to 
a memory card” on page 39. To convert audio files 
using a Macintosh, see the next section.

Converting audio files on a Macintosh

To convert audio files and attach them to EPSON 
Photo file format images so that they can be uploaded 
to the memory card in your camera from your 
Macintosh, follow the steps below.

1. Double-click the EPSON File Converter icon in 
the EPSON File Converter program group or 
folder. The EPSON File Converter dialog box 
appears.

2. Select the image files that you wish to attach audio 
files to and add them to the Selected File List. For 
more information about file selection, see 
“Converting images on a Macintosh” on page 52.
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3. Select an image file in the Selected File List to 
which you want to attach an audio file.

4. Click Select Sound to specify which audio 
recording file to link to that image file. In the 
dialog box that appears, locate and double-click 
the folder that contains the audio recording that 
you want to use. Audio files that can be converted 
are displayed.

5. Select the appropriate audio recording file and 
click Open.

Note:
Select the Show Preview check box, then select an 
audio recording file and click  to listen to a selected 
audio recording. 
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6. Repeat steps 3 to 5 as necessary to link audio 
recording files to image files for uploading. A 
speaker icon is displayed to the left of the file 
names in the Selected Files List for image files that 
have audio recordings attached.

Note:
❏ To listen to the audio recording associated with a 

selected image, click Play Sound.

❏ To remove an attached audio file from an image 
file, select the image file and click Delete Sound. 

7. When you are ready to save the selected files on 
your computer, click the Start button, then select 
the folder in which you want to save the files. The 
name of the currently selected folder appears in 
quotations next to Select on the button at the 
bottom of the dialog box.

8. Click the Select button. The files are converted 
and saved in the specified folder.

You are now ready to upload your files to the memory 
card in your camera using EPSON Photo!4. For 
instructions on uploading your files, see “Uploading 
files to a memory card” on page 39.

Making screen captures

You can make screen captures, or screen shots, of the 
images that appear on your computer screen so that 
they can be uploaded to the memory card in your 
camera. This allows you to include documents that 
you have created with your computer in a slide show 
on your camera, or to transfer image representations 
of your documents using a memory card.
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For Windows users

To make screen shots using EPSON File Converter, 
follow these steps.

1. To open EPSON File Converter, click Start, point 
to Programs, then to EPSON Camera and then 
to EPSON File Converter, then click EPSON File 
Converter. The Convert to the DCF file menu is 
displayed.

2. Click the Screen Capture tab. The Screen 
Capture menu is displayed.

3. Using the Drive list box and Folder list, specify the 
folder in which you would like to save the screen 
captures.

If you need to create a new folder for the images, 
click New Folder and type a folder name.

Note:
To select a folder located on a network drive, you may 
need to map the drive before opening EPSON File 
Converter. For details, see your Windows 
documentation.

4. Using the Hot Key settings, specify the key 
combination that you will press to make screen 
captures. Select the ALT, CTRL, or SHIFT check box, 
then select a key from the hot key list. The default 
hot key is the F5 key.

5. Click Start to register the key combination. When 
the key combination is registered, the Start button 
changes to a Stop button. The key combination 
remains registered only for the current session. 
Press the Stop button to erase the hot key 
combination.

file name box

Screen Capture tab
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6. Open your application, then open the document 
or file that you want to capture. Press the hot key 
combination that you specified. A screen capture 
file is created.

You can make as many screen captures as you 
like. Simply open the appropriate documents and 
press the screen capture key combination for each 
screen shot that you want to capture.

Note:
❏ The saved screen capture files are displayed below 

the Drive list box on EPSON File Converter’s 
Screen Shot menu.

❏ Screen capture file names are created 
automatically.

7. When you are finished making screen capture 
files, close your application. Then click the Stop 
button on the Screen Capture menu. The key 
combination that you specified is cleared.

To upload your screen capture files to the memory 
card in your camera, see “Uploading files to a memory 
card” on page 39.

For Macintosh users

EPSON File Converter for Macintosh does not have a 
screen shot feature. However, you can make screen 
shots using your Macintosh system software, then use 
EPSON File Converter to upload the screen shots to 
your camera.

While the instructions below are representative of 
many Macintosh computers, the procedure may 
differ, depending on your Macintosh. See your 
computer documentation for detailed instructions on 
making screen shots.

Follow these steps to make screen shots using your 
Macintosh.

1. Start the appropriate application and open the file 
that you want to make a screen capture of, then 
press SHIFT + COMMAND + 3 on your computer 
keyboard. Your Macintosh names and saves the 
entire screen image on your hard drive.

Note:
In OS 8 or later, you can also make a screen capture of 
any part of the screen image, rather than of the entire 
screen. Press SHIFT + COMMAND + 4, then click the 
window that you want to copy, or drag the cursor to 
draw a box around the area of the screen that you want 
to copy.
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Repeat this step to make as many screen shots as 
you like.

2. When you are finished making screen shots, close 
the application.

To upload your screen captures to the memory card 
in your camera, see “Uploading files to a memory 
card” on page 39.

Accessing EPSON PhotoQuicker

EPSON PhotoQuicker is a software application for 
printing digital images.

You can use PhotoQuicker to do the following.

❏ Print photos in various layouts

❏ Print photos on postcards, roll paper, or other 
types of paper.

❏ Apply various effects to images for printing.

Follow the steps below to start EPSON PhotoQuicker.

For Windows users

Click Start, point to Programs, and then to EPSON 
PhotoQuicker, then click EPSON PhotoQuicker 3.0. 
The main window of EPSON PhotoQuicker appears.

Note:
Click the Help icon for information on using EPSON 
PhotoQuicker.

For Macintosh users

Double-click the EPSON PhotoQuicker 3.0 icon in the 
EPSON PhotoQuicker 3.0 program group or folder. 
The main window of EPSON PhotoQuicker appears.

Note:
Click the Help icon for information on using EPSON 
PhotoQuicker.
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Accessing Panorama Stitcher Light EP

By using Panorama Stitcher Light EP, you can 
combine photos that were taken with the digital 
camera’s stitching function to create a panorama 
image. You can even create 360 degree panorama 
images.

Follow the steps below to start Panorama Stitcher 
Light EP.

For Windows Users

Click Start, point to Programs, then to EPSON 
Camera and then to Panorama Stitcher Light EP, 
then click Panorama Stitcher Light EP. The main 
window of Panorama Stitcher Light EP appears.

Note:
Click  for information on using Panorama Stitcher Light 
EP.

For Macintosh Users

Double-click the Panorama Stitcher Light EP icon in 
the EPSON Camera program group or folder. The 
main window of Panorama Stitcher Light EP appears.

Note:
Click  for information on using Panorama Stitcher Light 
EP.
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Your camera’s software is easy to use, and most 
problems that you encounter can be solved quickly 
and easily.

Refer to this section for solutions to common problems 
that may occur while using EPSON Photo!4.

Software Problems 

Find your problem in the list below, then try the 
solutions listed.

You cannot find your images in EPSON Photo!4.

If you are looking for images in the memory card, 
for photos, look in the 100EPSON folder (inside 
the DCIM folder), and for video clips, look in the 
MOVIE folder.

From the View menu, select Refresh to update the 
contents of the main window.

The drive for your camera does not appear in the left 
pane of the EPSON Photo!4 main window when you 
connect the camera to your computer. 

Make sure you are using the EPSON PhotoPC 
3100Z digital camera. EPSON Photo!4 cannot 
recognize any other camera models.

Make sure that the cable is connected correctly, as 
described in “Connecting the camera to your 
computer” on page 19.

Make sure that the camera’s dial switch is set to 
 and the camera is turned on.

Make sure that the batteries have enough power 
and are installed correctly, or use the optional AC 
adapter when connecting the camera to your 
computer.

Make sure that your camera has a memory card 
installed. If not, turn off the camera, insert a 
memory card, then set the camera’s dial switch to 

 and turn the camera back on.

In EPSON Photo!4, from the View menu, select 
Refresh to update the contents of the left pane.

Make sure that the port to which your camera is 
connected is properly configured, and that the 
Base I/O port address and the Interrupt Request 
Number (IRQ) assigned to the port are not in 
conflict with other devices.
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If you are using a Macintosh, make sure that the 
USB driver extension for your camera is selected 
in the Extensions Manager, or is located in the 
Extensions folder.

Try connecting the USB cable to another port on 
the USB hub.

Try connecting the camera directly to the USB 
port on your computer using the USB cable.

Try using a different USB hub if you have one.

An error message appears when you are using 
EPSON CameraStarter.

When you connect your camera to your 
computer

Make sure that the cable is connected correctly, as 
described in “Connecting the camera to your 
computer” on page 19.

Make sure that the camera’s dial switch is set to 
 and the camera is turned on. 

Make sure that the batteries have enough power 
and are installed correctly.

Make sure that the computer has enough memory 
and disk space.

Avoid opening or working with applications 
unrelated to the photo transfer process while the 
camera and computer are communicating.

When your insert the memory card into a PC Card 
slot of another device

Make sure the memory card in properly inserted 
into the PC Card slot, and that your device is 
properly connected to your computer and is 
turned on. For information on connecting your 
device to your computer, see the documentation 
for your device.

Note:
While the camera and computer are communicating, 
star icons move continuously across the camera's 
display panel.

Nothing happens when you click the SAVE, PRINT, 
or SAVE & PRINT icon in EPSON CameraStarter.

For printing images, make sure EPSON 
PhotoQuicker is installed in your computer. For 
downloading images from you memory card, 
make sure EPSON AutoDownloader is installed 
in your computer. For installation instructions, 
see “Installing the Software for Windows Users” 
on page 12, or “Installing the Software for 
Macintosh Users” on page 13.
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EPSON CameraStarter does not start.

Make sure the memory card has been used in the 
PhotoPC 3100Z. Memory cards formatted by 
other devices will not be recognized by EPSON 
CameraStarter.

Make sure EPSON CardMonitor is installed. For 
installation instructions, see “Installing the 
Software for Windows Users” on page 12 or 
“Installing the Software for Macintosh Users” on 
page 13.

Make sure your PhotoPC 3100Z is properly 
connected to your computer and is turned on. For 
instructions on connecting the camera, see 
“Connecting and Disconnecting the Camera” on 
page 19.

Make sure the batteries in the camera have 
sufficient power, or use the optional AC adapter.

EPSON PhotoQuicker does not start.

Make sure that EPSON PhotoQuicker is installed 
in your computer. For installation instructions, 
see “Installing the Software for Windows Users” 
on page 12 or “Installing the Software for 
Macintosh Users” on page 13.

On the Macintosh, to start EPSON PhotoQuicker 
from within EPSON Photo!4, make sure that there 
is 128 MB of memory available in your system. To 
change the amount of available system memory 
on your Macintosh, see your computer’s 
documentation. 

If you cannot make 128 MB of system memory 
available in your Macintosh, first transfer the 
images to your computer using EPSON 
AutoDownloader, close all applications, then 
start EPSON PhotoQuicker. For information on 
using EPSON AutoDownloader, see “Using 
EPSON AutoDownloader to Transfer Images” on 
page 23.
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If your camera is not operating properly and you 
cannot solve the problem using the troubleshooting 
information contained in this guide, contact customer 
support services for assistance.

To help us assist you more quickly, please provide the 
following information:

Serial number of your camera
(see the label on the bottom of the camera)

Camera model

Brand and model of your computer

EPSON Photo!4 software version
(click About on the Setup menu)

Operating system and version you are using
(for example, Windows 95 or Mac OS)

Software applications that you normally use 
with your camera and their version numbers

Note:
EPSON recommends making back-ups of your images 
before sending your camera for repairs. EPSON is not 
responsible for any lost images.

For United Kingdom and the Republic of 
Ireland Users

If you purchased your product in the UK or the 
Republic of Ireland, EPSON (UK) LTD provides a 
range of customer services and technical support.

Support via the World Wide Web

❏ For information on the latest EPSON products, 
software drivers, on-line user guides and answers 
to frequently asked questions:

http://www.epson.co.uk

❏ To email EPSON Technical Support:

http://www.epson.co.uk/support/email/

❏ For a full list of EPSON Customer and Warranty 
Support services:

http://www.epson.co.uk/support/
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Support via telephone

Our Customer and Warranty Support teams can be 
contacted by calling 0870 163 7766 in the UK or 0044 
0870 163 7766 from the Republic of Ireland. They can 
provide the following services:

❏ Technical information on installing, configuring 
and operating your EPSON products

❏ Arranging for faulty EPSON products to be 
repaired within the warranty period

Before you call, please have the following information 
ready:

Product model

Serial number of your product
(The serial number label is on the back of the 
product)

Brand and model of your computer

Driver software version
(Click the About button in your driver)

Operating System (for example, Windows 3.1/ 
95/98, NT 3.5/4.0, Mac OS)

Software application(s) that you normally use 
with your product and their version number(s)

Pre Sales Enquiry Desk

Our Enquiry Desk team can be contacted by calling 
0800 220546 in the UK or 1 800 409132 from the 
Republic of Ireland, by faxing 01442 227271 in the UK 
or 0044 1442 227271 from the Republic of Ireland, and 
via Email at info@epson.co.uk. They can provide the 
following information:

❏ Pre sales information and literature on new 
EPSON products (also available via our world 
wide web site at http://www.epson.co.uk)

❏ Where to purchase genuine EPSON consumables, 
accessories, and options

For Australia Users 

EPSON Australia wishes to provide you with a high 
level of customer service. As well as this User's Guide, 
we provide the following sources for obtaining 
information.
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EPSON FAXBACK

EPSON FAXBACK will fax you the latest 
specifications and pricing for most EPSON products 
offered in Australia. There is also technical 
information including details of the latest software 
and drivers available. Phone (02) 9903 9075 and the 
system will guide you through a number of choices 
before faxing the information to your fax machine.

EPSON Bulletin Board System

This is where you can download the latest software 
and drivers. Visit the BBS to check out the latest 
versions. If you have a modem, phone (02) 9417 5090.

Internet URL http://www.epson.com.au

Access the Epson Australia World Wide Web pages. 
Worth taking your modem here for the occasional 
surf! You can get the same information as offered on 
the EPSON FAXBACK and the EPSON Bulletin Board 
plus more.

Your dealer

Don’t forget that your dealer can often help identify 
and resolve problems. The dealer should always be 
the first call for advice on problems. They can often 
solve problems quickly and easily as well as give you 
advice on the next step to take.

EPSON Helpdesk

EPSON Helpdesk is provided as a final backup to 
make sure our clients have access to advice. Operators 
at the Helpdesk can aid you in diagnosing hardware 
and software problems. They can also advise you on 
the latest EPSON products and where the nearest 
dealer or service agent is located. Many types of 
queries are answered here.

The Helpdesk numbers are:

Phone: (02) 9903 9040

Fax: (02) 9903 9189
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We encourage you to have all the relevant information 
on hand when you ring. The more information you 
prepare, the faster we can help solve the problem. This 
information includes the User's Guide for your EPSON 
product, type of computer, operating system, 
application programs, and any other information you 
feel is required.

For Singapore Users 

Contact the telephone and fax numbers below.

For Hong Kong Users 

To obtain technical support as well as other after-sales 
services, users are welcome to contact EPSON Hong 
Kong Limited.

Internet home page

EPSON Hong Kong has established a local home page 
in both Chinese and English on the Internet to provide 
users with the following information.

❏ Product information

❏ Answers to Frequently Asked Questions (FAQs)

❏ Latest versions of EPSON camera software

Users can access our World Wide Web home page at: 
http://www.epson.com.hk

Phone: (065) 337-7911

Fax: (065) 334-1185
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Electronic Bulletin Board System

An electronic bulletin board system (BBS) is also 
available to obtain camera information and the latest 
versions of camera software. You can log on to the 
following number for the BBS service.

Technical Support Hotline

You can also contact our technical staff at the 
following telephone and fax numbers.

For Philippines Users 

To obtain technical support as well as other after sales 
services, users are welcome to contact the EPSON 
Philippines Representative Office at the telephone and 
fax numbers below.

BBS: (852) 2827-4244

Phone: (852) 2585-4399

Fax: (852) 2827-4383

Phone: (632) 813-6552

Fax: (632) 813-6545

BBS: (632) 814-0595
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Glossary

application
A software program that helps you carry out a particular task, 
such as word processing or financial planning.

BMP
A Windows file format for storing image data.

default
A value or setting that takes effect when the equipment is turned 
on, reset, or initialized. Also known as a factory setting.

drag-and-drop
Method for moving an on-screen object by holding the pointer 
over the object, pressing and holding the mouse button, 
dragging the mouse, then releasing the mouse button to drop 
the object in a new location.

Design rule for camera file system
Recording standard for image files. This standard has been 
established by the Japan Electronics and Information 
Technology Industries Association (JEITA).

DPOF 
Digital Print Order Format. Settings for the number of prints and 
for index prints are saved in a DPOF file on the camera's memory 
card. You can apply these settings when using a printer or 
printing application that supports the DPOF standard.

Exif2.1
Standard format for audio/image files. This standard has been 
established by the Japan Electronics and Information 
Technology Industries Association (JEITA). 

grayscale
Images represented using various shades of gray in addition to 
black and white.

interface
The connection between the computer and the camera.

JPEG
A file format used for storing color and grayscale images in 
compressed files. Data saved using the JPEG format generally 
receives greater compression than data saved using TIFF and 
other formats. See TIFF.

PICT
A file format widely used for Macintosh graphics.

pixel
Short for picture element. Each image is composed of a 
number of pixels. Pixels are also counted in units of dots.

port
An interface channel through which data is transmitted between 
devices.
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PRINT Image Matching
A new standard that allows digital cameras to record special 
information about the photos it takes and relay that information 
seamlessly to a printer compatible with this standard. This 
information can be used by printers that support the PRINT 
Image Matching system for enhanced printing results.

resolution
Indication of how finely an image is resolved into pixels. Often 
measured in dots per inch (dpi) or pixels per inch (ppi).

thumbnails
Small representations of images.

TIFF
A file format for storing color and grayscale images in files with 
little or no data compression. (TIFF files made with EPSON 
digital cameras receive no data compression.) Saving data in the 
TIFF format results in files that are larger and have finer image 
quality than image files with greater data compression, such as 
JPEG and other format files. See JPEG.

USB
Universal Serial Bus. A hardware interface for connecting one 
or more low-speed peripherals, such as a keyboard, mouse, 
scanner, or printer, to the computer.

USB hub
A device that normally provides four TYPE A sockets to increase 
the number of USB ports on a computer.
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Index

A
Accessing

EPSON AutoDownloader from EPSON CameraStarter, 24
EPSON AutoDownloader from Windows, 23
EPSON AutoDownloader from your Macintosh, 24
EPSON File Converter from Windows, 48
EPSON File Converter from your Macintosh, 52
EPSON Photo!4, 27
EPSON PhotoQuicker, 43, 59
Panorama Stitcher Light EP, 60

Acrobat Reader
installing in Windows, 12
installing on your Macintosh, 15

Adding user comments to images, 39
Advanced menu, 23, 24, 25
AIFF file format, 48
Audio recordings

converting in Windows, 50 to 52
converting using a Macintosh, 54 to 56
locking, 38
playing back, 34
sending via e-mail, 41 to 42
unlocking, 38
uploading to a CompactFlash Card, 39

Auto shut-off, 20

B
Base Folder, 28

BMP file format, 48
Buttons

control panel for slide show, 36
details, 29
hiding image information, 31
Image Viewer window, 34
large thumbnails, 29, 31
medium thumbnails, 29, 31
opening images, 34
photo info, 31
rotation, 40
selecting all images, 30
showing image information, 30, 31
small thumbnails, 29

C
Camera

connecting to your computer, 19
disconnecting from a Macintosh, 22
disconnecting from your computer in Windows 2000, 22
disconnecting from your computer in Windows Me and 98, 22

Camera Card drive, 28
Camera ID, 31
Camera indicator lights, 21
Changing file names, 38
Changing folder names, 38
CompactFlash Card

downloading files from, 23
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uploading files to, 39
Connecting the camera to your computer, 19
Converting

audio recordings in Windows, 50 to 52
audio recordings using a Macintosh, 54 to 56
images in Windows, 48 to 50
images using a Macintosh, 52 to 54

Convert to the DCF file menu, 48 to 52
Copying files, 39
Customer support, 66 to 70

D
Details View menu, 32
Disconnecting the camera

from a Macintosh, 22
from your computer in Windows 2000, 22
from your computer in Windows Me and 98, 22

Downloading files from a CompactFlash Card, 23
DPOF settings, 47
Drives

Camera Card, 28
EPSON Camera, 28
selecting in EPSON Photo!4, 28
Source Drive, 46

E
EPSON AutoDownloader

accessing from EPSON CameraStarter, 24 to 25
accessing from Windows, 23 to 24
accessing from your Macintosh, 24
installing in Windows, 12
installing on your Macintosh, 13

EPSON Camera drive, 28
EPSON CameraStarter

accessing EPSON AutoDownloader, 24
features, 16
installing in Windows, 12
installing on your Macintosh, 13
using, 45 to 47

EPSON CardMonitor
installing in Windows, 12
installing on your Macintosh, 13

EPSON File Converter
accessing from Windows, 48
accessing from your Macintosh, 52
Convert to the DCF file menu, 48 to 52
installing in Windows, 12
installing on your Macintosh, 13
making screen captures, 56 to 59
Preview, 49, 53
Screen Capture menu, 56 to 58
using, 48 to 59

EPSON Photo!4
adding user comments, 39
changing file names, 38
changing folder names, 38
copy files, 39
deleting files, 38
Image Viewer window, 33
installing in Windows, 12
installing on your Macintosh, 13
locking files, 38
moving files, 38
playing back audio recordings, 34
playing back video clips, 34
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printing photos, 43
rotating photos, 40
search function, 37
selecting drives, 28
selecting folders, 28
selecting images, 30
sending files via e-mail, 41 to 42
slide show, 35 to 37
starting, 27
unlocking files, 38
uploading files to a CompactFlash Card, 39
using, 27 to 43
using a photo as wallpaper, 40
viewing a list of files, 29
viewing image information, 30 to 33
viewing thumbnail images, 29

EPSON Photo file format image files, 28
EPSON PhotoQuicker

accessing, 43, 59
installing in Windows, 12
installing on your Macintosh, 13

Erasing files, 38

F
File formats

AIFF, 48
BMP, 48
JPEG, 30, 31, 48
TIFF, 30, 31
WAV, 48

Files and Folders menu, 23, 24, 25
Folders

Base Folder, 28
changing names, 38
Recent Search Results, 29, 37
selecting in EPSON Photo!4, 28

H
Help, 23

I
Icons

image information in a list of files, 31
image information in thumbnails, 30

Image information
changing items shown, 32
viewing in a list of files, 31
viewing in thumbnails, 30
viewing using the Properties dialog box, 32

Image Viewer window
buttons, 34
using, 33

Indicator lights, 21
Installing

Acrobat Reader in Windows, 12
Acrobat Reader on your Macintosh, 15
EPSON AutoDownloader in Windows, 12
EPSON AutoDownloader on your Macintosh, 13
EPSON CameraStarter in Windows, 12
EPSON CameraStarter on your Macintosh, 13
EPSON CardMonitor in Windows, 12
EPSON CardMonitor on your Macintosh, 13
EPSON File Converter in Windows, 12
EPSON File Converter on your Macintosh, 13
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EPSON Photo!4 in Windows, 12
EPSON Photo!4 on your Macintosh, 13
EPSON PhotoQuicker in Windows, 12
EPSON PhotoQuicker on your Macintosh, 13
Panorama Stitcher Light EP in Windows, 12
Panorama Stitcher Light EP on your Macintosh, 13
QuickTime 4 in Windows, 12
QuickTime 4 on your Macintosh, 15
Software in Windows, 12
Software on your Macintosh, 13
USB driver in Windows, 12
USB driver on your Macintosh, 13

J
JPEG file format, 30, 31, 48

L
Locking files, 38

M
Making screen captures, 56 to 59
Memory card, See CompactFlash Card
Menus

Advanced, 23, 24, 25
Convert to the DCF file, 48 to 52
Details View, 32
Files and Folders, 23, 24, 25
Screen Capture, 57 to 58
Slideshow, 35

Moving files, 38

P
Panorama Stitcher Light EP

accessing, 60
installing in Windows, 12
installing on your Macintosh, 13

Photos
adding user comments to, 39
changing file names, 38
copying, 39
erasing, 38
getting information on, 31
locking, 38
moving, 38
printing, 43
rotating, 40
selecting in EPSON Photo!4, 30
sending via e-mail, 41 to 42
unlocking, 38
using as wallpaper, 40
viewing information, 30 to 33
viewing properties, 32
viewing thumbnail, 29

Pictures, See Photos
Playing back

audio recordings, 34
video clips, 34

Printing photos, 43

Q
QuickTime 4

installing in Windows, 12
installing on your Macintosh, 15
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R
Recent Search Results folder, 29, 37
Rotating photos, 40
Running a slide show, 36

S
Screen Capture menu, 57 to 58
Search function, 37
Selecting

drives in EPSON Photo!4, 28
folders in EPSON Photo!4, 28
images in EPSON Photo!4, 30

Sending files via e-mail, 41 to 42
Settings

Base Folder, 28
changing image information items shown, 32
slide show, 35

Slide show
buttons in the control panel, 36
running, 36
settings, 35

Slideshow menu, 35
Software

installing in Windows, 12
installing on your Macintosh, 13

Source Drive, 46
Starting

EPSON AutoDownloader from EPSON CameraStarter, 24
EPSON AutoDownloader from Windows, 23
EPSON AutoDownloader from your Macintosh, 24
EPSON File Converter from Windows, 48
EPSON File Converter from your Macintosh, 52

EPSON Photo!4, 27
EPSON PhotoQuicker, 43, 59
Panorama Stitcher Light EP, 60

System requirements
for Macintosh, 8
for Windows, 8

T
TIFF file format, 30, 31
Troubleshooting, 62 to 64

U
Unlocking files, 38
Uploading files to a CompactFlash Card, 39
USB cable, 19, 22
USB driver

installing in Windows, 12
installing on your Macintosh, 13

User comments, 33, 39
Using a photo as wallpaper, 40

V
Video clips

adding user comments to, 39
changing file names, 38
copying, 39
erasing, 38
locking, 38
moving, 38
playing back, 34
selecting in EPSON Photo!4, 30
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sending via e-mail, 41 to 42
unlocking, 38
viewing information, 30 to 33
viewing properties, 32
viewing thumbnail, 29

Viewing
a list of files, 29
image information in a list of files, 31
image information in thumbnails, 30
image information using the Properties dialog box, 32
images in the Image Viewer window, 33
photo information, 31
properties, 32
thumbnail images, 29

W
WAV file format, 48
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EPSON OVERSEAS MARKETING LOCATIONS

Epson America, Inc.
3840 Kilroy Airport Way
Long Beach, CA 90806
Phone:  (562) 981-3840
Fax:  (562) 290-5220

EPSON UK LTD.
Campus 100, Maylands Avenue,
Hemel Hempstead, Herts, 
HP2 7TJ, U.K.
Phone:  (+44) 01442 261144
Fax:  (+44) 01442 227227

EPSON DEUTSCHLAND GmbH
Zülpicher Straße 6,
40549 Düsseldorf Germany
Phone: (0211) 56030 
Fax:  (0211) 5047787

EPSON FRANCE S.A. 
68 bis, rue Marjolin
92300, Levallois-Perret, France
Phone:  33.1.41.86.26.56
Telex:  610657

EPSON AUSTRALIA PTY. 
LTD.
70 GIBBES STREET,
CHATSWOOD 2067 NSW. 
Phone:  2-9903-9000 
Fax:  2-9903-9177

EPSON SINGAPORE PTE. LTD.
No. 1 Temasek Avenue #36-00
Millenia Tower, Singapore 039192
Phone:  (065) 33 77 911 
Fax:  (065) 33 41 185

EPSON HONG KONG LTD.
Rooms 4706-10, 47/F, 
China Resources Bldg., 
26 Harbour Road, Wanchai, 
Hong Kong 
Phone:  2585-4300 
Fax:  2827-7083

EPSON TAIWAN TECHNOLOGY & 
TRADING LTD.
10F, No. 287 Nanking E. Road, Sec. 3, 
Taipei, Taiwan, R.O.C. 
Phone:  (02) 717-7360 
Fax:  (02) 712-9164

EPSON ITALIA S.p.A.
V.le F.lli Casiraghi 427 
20099 Sesto S.Giovanni 
MI, Italy 
Phone:  +3902262331 
Fax:  +39022440750

EPSON IBERICA S.A.
Av. de Roma, 18-26 
08290 Cerdanyola del Valles 
Barcelona, Spain 
Phone:  582. 15.00 
Fax:  582. 15.55

EPSON PORTUGAL, S.A.
R. do Progresso, 471, 1° Perafita 
4460 Matosinhos, Portugal
Phone:  (02) 996 14 02
Fax:  (02) 996 14 11

SEIKO EPSON CORPORATION 
(Hirooka Office) 
80 Harashinden, Hirooka
Shiojiri-shi, Nagano-ken
399-0785 Japan
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